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Preface 
 

 

This manual describes the setup and operation of the Provincial 9-1-1 Printer Data 

Capture application. The P911 PDC application is a program designed to capture the 

printable ASCII data sent to the LOG printer and Real-time printer ports of Call Answer 

Centres in British Columbia or Alberta, split the data into component fields, and store 

the data in a database for archival, reporting, and statistical purposes. 
 

 

Structure of This Document 
 

 

The document is divided into three parts: 

 

¶ A section that describes the operating system and hardware requirements and 

installation of the Provincial 9-1-1 Printer Data Capture application. 

¶ A section describing the operation of the program. 

¶ A section describing the Searching and Reporting Microsoft Access module 

 

Intended Audience 
 

 

This manual is intended for those individuals in the 9-1-1 Call Answer Centres who are 

charged with the collection and maintenance of statistical 9-1-1 call information. A 

working knowledge of appropriate database tools and reporting utilities is assumed.
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1 Provincial 9-1-1 Printer Data Capture Overview 
 

The Provincial 9-1-1 Printer Data Capture application is a Microsoft Windows program 

that is designed to capture and record 9-1-1 call data for statistical, archival, and 

reporting purposes. It may be used to replace hard-copy printers at 9-1-1 Call Answer 

Centres in both British Columbia and Alberta. Rather than feed the serial output of the 

LOG printer and Real-time printer ports to hard-copy printers, they may be attached to 

the serial COM ports of a PC with the Printer Data Capture application installed. The 

utility will then capture the ASCII printer data stream, split the data stream into 

component fields, and store the data into a user database. The Call Answer Centre may 

use an appropriate reporting tool to produce summaries and statistical reports of 9-1-1 

calls. 

1.1 Requirements 
 

The Provincial 9-1-1 Printer Data Capture application requires the following hardware 

and software requirements for proper operation: 

 

¶ A Pentium class PC with at least one serial port connected to the LOG printer 

port of a terminal server. To collect Realtime printer data, a second serial port 

must be present. 

¶ A hard drive of sufficient size to support the database and log files. 

¶ Windows 98, Windows XP Professional, Windows 2000 Professional, Windows 

2000 Server, or Windows Server 2003 operating system installed.  Running the 

application in Windows Service mode is not available when installed under 

Windows 98 due to limitations of the operating system. 

¶ The Microsoft .NET Framework Version 4.5 Redistributable Package must be 

installed. This is provided on the installation CD-ROM, or may be may be 

downloaded from Microsoft at: dotnetfx.exe. 

¶ The Crystal Reports Runtime files must be installed.  The installation package is 

provided on the distribution CD-ROM or may be downloaded from 

https://ngc1952.homeserver.com/p911pdc/CRRuntime_32bit_13_0_1.msi. 

¶ Microsoft Data Access Components (MDAC) 2.8. MDAC 2.8 is provided on the 

installation CD-ROM, or may be downloaded from Microsoft at the Microsoft 

Download Centre. Windows XP and Windows Server 2003 already include MDAC 

2.8. 

 

The following components are optional: 

 

¶ Microsoft Access 2000 or 2003 installed if you wish to store data in an Access 

database. 

¶ Microsoft SQL Server 2000 or 2005 if you wish to store data in an SQL Server 

database. 

¶ MySQL and the MySQL ODBC connector installed if you wish to store data in a 

MySQL database. 

1.2 Components 
 

http://www.microsoft.com/downloads/details.aspx?familyid=0856EACB-4362-4B0D-8EDD-AAB15C5E04F5&displaylang=en
https://ngc1952.homeserver.com/p911pdc/CRRuntime_32bit_13_0_1.msi
http://www.microsoft.com/downloads/details.aspx?FamilyID=6c050fe3-c795-4b7d-b037-185d0506396c&DisplayLang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=6c050fe3-c795-4b7d-b037-185d0506396c&DisplayLang=en
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The Provincial 9-1-1 Printer Data Capture application is provided on a CD-ROM with the 

following components: 

 

¶ P911PDCSetup.exe – The installation program for the Printer Data Capture 

application. 

¶ CRRedist2005_x86.msi  – The runtime modules for Crystal Reports, required by 

the P911PDC program. 

¶ p911callstats.mdb  – A Microsoft Access database with an empty table named 

callstats  into which the captured printer data may be stored. It also includes 

empty tables that are required by the reporting module that are customized by 

site. 

¶ mysql -4.0.17-win.zip  – The MySQL database Windows installation 

¶ MySQL Manual.pdf  - The MySQL reference manual in Adobe Acrobat format 

¶ MyODBC -3.51.06.exe - The MySQL ODBC connector installation file. 

¶ mysqlcc-0.9.4-win32.zip  - The MySQL Control Centre installation file. 

¶ Create Tables MySQL .sql - An SQL script used to create the callstats , and other 

tables required by the reporting module table in MySQL 

¶ Create Tables SQL2K .sql – An SQL script used to create the callstats  table, and 

other tables required by the reporting module in Microsoft SQL Server 2000. 

¶ dotnetfx.exe - The Microsoft .NET Framework Version 1.1 Redistributable 

Package 

¶ P911 Reporting.mdb  – A sample Microsoft Access database application that 

allows you to search for collected 9-1-1 call records. It also contains a sample 

report that breaks down 9-1-1 call distribution by hour of day. 

¶ Provincial 9-1-1 Printer Data Capture.pdf  – This document. 

 

1.3 Installation 
 

To install the Provincial 9-1-1 Printer Data Capture application click on the 

P911PDCSetup program. You will be prompted for a destination folder into which the 

application will be installed. The default folder is C:\P911PDC. The setup program will 

then copy the following files to the destination folder: 

 

Table 1 - Installed files 

P911PDC.exe Printer Data Capture capture/client module 

P911PDCService.exe Windows Service data capture module 

P911PDCLIB.DLL Support routines common to both the display and service 

modules 

p911callstats.mdb Empty Microsoft Access database for storing captured data 

Installation.mdb Site specific database for customizing reports 

Create Tables MySQL.sql 

Create Tables SQL2K.sql 

Scripts for creating the callstats table in both MySQL and 

SQL Server 2000 

P911 Reporting.mdb Microsoft Access database application for searching, 

reporting and customizing reports 

Provincial 9-1-1Printer 

Data Capture.pdf 

This documentation 

http://www.microsoft.com/downloads/details.aspx?familyid=0856EACB-4362-4B0D-8EDD-AAB15C5E04F5&displaylang=en
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Existing p911callstats.mdb , Installation.mdb , and P911 Reporting.mdb  files will not be 

overwritten. 

1.4 Uninstallation 
 

To uninstall the Printer Data Capture application, open Control Panel → Add or Remove 

programs and click on the “Remove” button beside the Provincial 9-1-1 Printer Data 

Capture icon. The PDC Windows Service will be stopped and removed, and the 

application files will be deleted. However, the following files will not be removed, since 

they may contain collected data or site-specific modifications: 

 

¶ p911callstats.mdb  

¶ P911 Reporting.mdb  

¶ Installation.mdb  

¶ Log files created by the application  

¶ Any files in the application directory not created by the installation program  

1.5 Upgrading 
 

When upgrading the Printer Data Capture application to a new version, you generally do 

not need to uninstall the previous version first. The setup program will automatically 

take care of uninstalling an existing version for you, and it will preserve all existing 

settings. 

1.6 Contact 
 

To report any errors or problems, or to request additional reports, please contact the 

author: 

 

Email:    colin@ngc1952.com 

Phone:    604.731.3106 

Home Page: http://www.ngc1952.com 

 

In the case of error reporting, be prepared to supply the log file containing the errors. 

mailto:colin@ngc1952.com
http://www.ngc1952.com/
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1.7 Program Revision History 
V4.0.8  11-Aug-2011 

¶ Add email notification for certain errors 

¶ Change date/time displays on search reports to 24 hour clock 

¶ Add failover server to SQL server connection string 

 

V4.0.7  06-Jun-2011 

¶ Ensure that if not collecting to any database due to database startup errors and not 

retrying database connection, that data is logged to logfile for future import. 

 

V4.0.6  27-Jan-2011 

¶ Add up to COM9 in options COM port dropdown. 

 

V4.0.5  10-Mar-2010 

¶ When option to start minimized was set, window would be briefly visible before 

minimizing when program started. 

¶ When program was started minimized and then restored, panels would sometimes be 

shifted to the right. 

 

V4.0.4  4-Mar-2010 

¶ Improved error message when there are problems connecting to the database on 

application startup. If there are problems connecting to the storage database on 

startup, an error message will be logged indicating that data collection to the 

problem database will be disabled until the problem is fixed. 

¶ DNS host name as well as IP address may now be specified in the server address 

field when you are running P911PDC as a Windows Service and you wish to connect 

to it in client mode. 

¶ Display of panels and windows is now controlled only by Options->Display tab. 

Previously, when running in client mode, you had limited control over which panels 

and windows appeared. Now the client can continue to receive LOG printer and 

Realtime printer data from the server and has full control over what data is 

displayed. History is still maintained for panels and windows that are hidden. 

¶ Improved positioning of LOG printer and Realtime printer display panes when 

application window is resized. 

¶ When running P911PDC as a Windows Service you may now specify service 

dependencies. A service dependency causes the P911PDC Windows Service to delay 

startup until the services it is dependent on are started. Consider the scenario where 

P911PDC is set to store printer data in an SQL Server database running on the same 

machine. When the machine is booted, if the P911PDC service starts before the SQL 

service is started, P911PDC will fail to connect to the database and no data will be 

stored in SQL server until the P911PDC service is restarted. However, if a 

dependency is added on the SQL Server service, the P911PDC will delay startup 

until the SQL server service is running, thereby ensuring it can connect to the 

database. You should specify the service name as either: 

o MSSQLSERVER if you are running SQL Server Enterprise 

o MSSQL$EXPRESS if you are running SQL Server Express 

You only need to specify the dependency if you are running P911PDC on the same 

machine as SQL server and you are collecting data to the local SQL server database. 

Leave this field blank if it does not apply. 

 

V4.0.0  23-Oct-2009 

¶ Improve regular expressions used for matching fields. 
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¶ Add support for new LOG printer Type 4 format, which may include Wireless Phase 

II location information. 

¶ Improve database searches, stores, and updates. 

¶ Replace multiple trailing line feeds in captured printer data with single crlf. 

¶ Begin to make storage table name a setting. 

¶ Modify panels to support larger font sizes. Maximum font size is 14. 

¶ Modify panels to support 1024x768 screen size (smallest resolution supported). 

¶ Adjust panel placement when window size is changed. 

¶ Support Microsoft Access 2007 database type .accdb 

 

V3.7.3  27-Jan-2008 

¶ In StoreRecord routine, if required database connection not open, then open it. 

Handles case of database being inaccessible when program starts but comes online 

later. 

¶ Fix parsing of host address in ConnectTo routine of SmartSockets, broken because 

Vista may return a list of IPV4 and IPV6 addresses. 

¶ Check for proper Windows Service TCP/IP address in Options tab Other. 

¶ Activate proper tab when Options are in error. 

 

V3.7.2  12-May-2007 

¶ Rearrange size and spacing of text boxes on panels to accommodate larger fonts. 

¶ Allow changing of font on Realtime and LOG panels. 

¶ Add option to format phone numbers. 

 

V3.7.1  21-Feb-2007 

¶ Add option to prevent closing or minimizing of window when run under non-

administrative account. 

 

V3.7.0  9-Oct-2006 

¶ Updated documentation. 

¶ Support the 5 types of printer formats available from TELUS and documented in the 

Terminal -to-Network Interfaces For Provincial 9 -1-1 Service Alberta and British 

Columbia . This document may be downloaded from 

http://about.telus.com/publicpolicy/pdf/TID-08.pdf. 

¶ Automatic selection of proper printer format based on what is seen at the printer 

port. 

¶ Fix bug where if "display as received" was set, all raw data was displayed in the raw 

realtime printer display window. 

¶ Fix bug where clear button did not clear fields in Call Detail Report search window. 

¶ In order to conserve database resources, when producing reports from a client where 

the data collection is running as a Windows service (local or remote), only connect to 

database as needed, rather than keeping the connection always open. 

¶ When updating an existing LOG record with a realtime record, update the 

PSAPName since the PSAPName from the LOG record may be truncated. 

Conversely, when updating an existing realtime record with a LOG record, don't 

update the PSAPName, since it may be truncated. The realtime printer record will 

always contain a full PSAPName. 

 

V3.6.2  11-Apr-2006 

¶ Added a print button to the LOG printer and Realtime printer panels to print the 

currently displayed record. Printer options may be set in the new File->Printer 

Settings... menu item. 

¶ Added print button to the Abandoned Attempt Alarm forms. 

http://about.telus.com/publicpolicy/pdf/TID-08.pdf
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V3.6.0  07-Apr-2006 

¶ Connect to local service even if service is paused. 

¶ Add method to flush remaining records in storage queue to logfile if shutting down. 

¶ Only reconnect to databases if serious connectivity error occurs. This will prevent an 

infinite retry loop if there is an error in one of the database fields. 

¶ Fixed Recent record search of Call Details Report. 

¶ In Realtime record storage routines possible clock change wasn't being taken into 

account, so sometimes it wouldn't update the existing LOG record. 

 

V3.5.4  27-Mar-2006 

¶ Add support for printer formats as used in TELUS Alberta. 

¶ Restart threads if they crash unexpectedly. 

¶ Upgraded to Visual Studio .NET 2005 

¶ Added option to switch positions of realtime and LOG printer panels 

¶ Make logging window, realtime printer raw data window, and LOG printer raw data 

window optional. 

¶ Reworked searching SQL code 

¶ Add option to beep PC speaker when BEL characters found in printer stream 

¶ Add option to pop up alarm window on unanswered calls (abandoned attempts) 

¶ Reworked database connection code. 

¶ Add import function to import skipped records from log file 

 

V3.4.1  30-Jun-2005 

¶ Transfer PSAP Name wasn't being collected if call was not answered at transferred-

to PSAP. 

¶ Saved SQL Server database name was being ignored and "p911callstats" was always 

being opened. 

¶ Added Call Details report. 

¶ Add pause/resume so that application can disconnect from database temporarily 

while still collecting data but not storing it until resume is selected. This allows an 

Access database to be modified and not lose any data 

 

V3.3.4  27-May-2005 

¶ Add trace facility to debug matching and updating of Realtime and LOG records. 

¶ Better handling of record locking in Access database. 

¶ Improve method by which LOG and Realtime printer records are matched and 

updated in the databases. 

 

V3.3.2  22-Apr-2005 

¶ Correct bug when updating existing Realtime data from LOG printer data in SQL 

Server. 

¶ Add statistics display. 

¶ Improve algorithm that finds existing Realtime printer data to update with LOG 

printer data for all databases. 

¶ Fix display of SQL SELECT statement when more than one existing Realtime 

printer record is updated with LOG printer data. 

 

V3.3.1  18-Apr-2005 

¶ Add ability to change font type, size, and color in LOG printer, Realtime printer and 

Logging output windows. 
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V3.3.0  15-Apr-2005 

¶ Remove ProcessBuffer thread and add ProcessData routine called in each serial port 

read thread. 

¶ Increase serial port input buffer size to prevent buffer overruns. 

¶ Prevent multiple duplicate entries from appearing in dropdown lists on search forms. 

¶ Change raw printer text output windows from RichTextBox to multiline TextBox and 

limit the amount of text displayed to prevent memory consumption. 

¶ Add a registry fix to prevent the Jet OLE DB provider from consuming too much 

memory as outlined in Microsoft Knowledgebase article 

http://support.microsoft.com/kb/248014/EN-US/ 

¶ Increase process priority of data collector so it will be more responsive to incoming 

data. 

¶ Show a wait cursor when doing a lengthy database search. 

¶ When searching for LOG or Realtime printer records to update, update the first 

matching record with the minimum time difference between RTCallTime and 

AnswerTime (or DisconnectTime if abandoned). 

¶ Display raw printer output in log file when there is an error storing it in all 

databases. 

 

V3.2.1  23-Mar-2005 

Prevent running multiple programs. If another copy is started, activate the existing 

running program and exit. When in client mode, if a printer is not defined, and a 

message comes in to update that printers' window, make the window visible. Respace 

form controls slightly so that more can be seen on low resolution screens. Make search 

form font match that of the main form. 

 

V3.2.0  18-Mar-2005 

Added a Search button for both LOG print and Realtime print display panels.  The 

Search button brings up a Search window that allows you to search for records based on 

input selections such as date, PSAP Name, ESZ, Customer Name, Address, etc.  The 

search results are shown in a Crystal Reports report window, allowing you to print or 

export the report.  This distribution file is larger than normal due to the necessity of 

providing the Crystal Reports .NET runtime libraries along with the application. 

 

V3.1.1  24-Feb-2005 

Rewrite application in C#. Only log LOG and Real-time data records to log file when 

there is a problem storing the data in the database. Implement “local service”, so 

P911PDC.EXE can be run in client-only mode and connect to the Service running on 

another machine. Add native SQL Server 2000 database support. Add “Test” buttons to 

database selection options to test proper connection to databases. Combine LOG printer 

and Real-time printer data processing threads into single thread. 

 

V3.0.0  15-Oct-2004 

Split data capture, settings save/restore, and logger into classes. Add P911PDCService 

program so data capture can be run as a Windows Service. Add ClientUpdate class and 

SmartSocket class so service can send updates to display client(s). Add an installer. Move 

all common routines to a support library. 

 

V2.3.1  29-Jun-2004 

Added options to start the program minimized and to hide the program in the system 

tray when minimized. 

 

http://support.microsoft.com/kb/248014/EN-US/
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V2.3.0  23-Apr-2004 

Merge and store data from real-time printer in database. 

 

V2.2.1  13-Apr-2004 

Fix 24-hour clock times displayed and stored. Correct parsing of RCER dates and times 

where OFFER, ANSWER, TRANSFER, and TRANSFER ANSWER times may be in 

previous day than DISCONNECT time. 

 

V2.2.0  7-Apr-2004 

Fix ParseRCER parsing of date routine. Format date with alpha month to make month 

and day unambiguous. Fix parsing of LOG and Realtime printer records with an ESZ 

present but no Municipality or Postal Code. 

 

V2.1.0  1-Apr-2004 

Add ability to use incoming TCP/IP connections for printers rather than serial ports. This 

option would be used mainly for testing purposes. Fix bug where using Access Database 

file selection button on Options form would cause Options form to close. 

 

V2.0.0  1-Mar-2004 

Original version of program. 
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2 Provincial 9-1-1 Printer Data Capture Operation 
 

2.1 Starting 
 

To execute the Printer Data Capture application, double-click on the P911PDC.exe 

program icon. The Windows interface generally consists of 2 panels and 3 windows, but 

may not appear exactly as pictured below depending upon how the application is 

configured. 
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The top panel contains the field display of the data read from the LOG printer port. The 

panel directly underneath contains the field display of data read from the Real-time 

printer. The three lower windows consist of the raw LOG printer display window, the 

raw Real-time printer display window, and the logging window that contains error and 

informational messages. 

 

2.2 Configuration 
 

Before the utility can begin to capture and store data, you must configure which serial 

ports are connected to which Provincial 9-1-1 printers. To begin configuration, select File 

→ Options… from the menu bar. 
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After Options is selected, you will be presented with the Printers tab. 

 

 
 

Select the serial communications port that the LOG printer is attached to, and optionally 

the serial port that the Real-time printer is attached to. The choices are COM1 through 

COM4. You may also configure the serial port settings such as baud rate and flow control 

as recommended by the 9-1-1 terminal interface document. For British Columbia and 

Alberta the defaults of 9600 baud, no flow control, 8 data bits, no parity, and 1 stop bit 

should be appropriate. 

 

The “Use TCP/IP” checkboxes and port number fields are intended to be used or 

debugging. If checked, instead of reading data from the serial ports, the program will 

listen on the specified TCP/IP port for an incoming connection from a printer. These 

would not normally be checked as TELUS does not provide network printing for 9-1-1. 
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The next tab, Databases, allows you to select the database into which the collected data 

will be stored. You have a choice of a Microsoft Access database, an ODBC (Open 

Database Connectivity) database, or an SQL Server 2000/2005 database. The ODBC 

database may be any third party database that you have installed an ODBC connector 

for, such as MySQL, or Oracle. You may choose to store data in any or all databases 

simultaneously. 

 

 
 

In the Microsoft Access Database group, press the Search button to select the location of 

the Microsoft Access database file. 

 

In the ODBC Database group, the Dataset dropdown box will present you with a list of 

defined ODBC connectors. If the ODBC database requires authentication, the username 

and password may be supplied. The connector may be defined and configure in the 

Control Panel Data Sources (ODBC) applet. 

 

In the SQL Server group, type the address of the networked SQL Server machine where 

the database is located. If the database is located on the machine where the data capture 

software is installed, enter localhost , or 127.0.0.1. If you are using database 

authentication, supply the username and password of a user that has read/write access 

to the database. 
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Any databases selected must contain a table named callstats , with the required named 

table fields as described in a subsequent section. The Test button in each group will test 

the connection to the database. 

 

The third tab, Alarms, sets alarm options for the data seen at the printers. 

 

 
 

You may choose to have the PC speaker beep when bell characters are seen in the printer 

input stream. You may also choose to have a popup window displayed when an 

Abandoned Attempt is seen at either or both of the printers. Abandoned attempts are 

9-1-1 calls where the caller hangs up before the operator answers. The popup window 

contains basic caller information, and will remain displayed until explicitly dismissed. 

Multiple Abandoned Attempt popup windows may be active at the same time. 
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The last tab, Other, contains several sections that allow you to configure how the 

program starts, how the windows and panels are displayed, and whether it runs as a 

Windows Service or not. Windows Service mode is described in Section 2.7 

 

 
 

The sections and their options are described as follows: 

 

Table 2 - Startup 

Start with Windows 

If checked, the application will start when Windows 

starts and a user logs in. In standalone mode, the user 

must have administrative privileges. In client/server 

mode, administrative privileges are required only if 

client will be used to control the server. 

Start minimized If checked, the application will start minimized. 

Minimize to system tray 

If checked, when the application is minimized it will 

show an icon in the system tray area, but not the 

taskbar. Double-clicking the tray icon will restore the 

program window to a normal state, while right-clicking 

the icon will present a context menu that will allow you 

to restore the window, or exit the program. 

 

The Fonts section contains buttons that bring upa font dialog box that will allow you to 

change the font, font size, and font color for each of the LOG, realtime, and Logging 

windows. 
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Table 3 - Windows Service Options 

Run as Windows Service 

If checked, the application will run as a Windows 

Service. It will automatically run and start collecting 

data when the PC boots. An administrative user does 

not have to log in first to start the program. The 

application will continue to run even if no one is logged 

on, or the P911PDC.exe is shut down. This is the 

recommended mode of operation. If not checked, the 

application will run standalone and connect to the COM 

ports directly. 

Local Service 

This option is only important if the “Run as Windows 

Service” option is checked. If checked, the program will 

attempt to connect to and control the P911PDC 

Windows Service on the current machine. If not 

checked, the program will attempt to connect to a 

Service running on the machine as specified by the 

Service Address. 

Service Port 

When the application runs as a Windows Service, the 

P911PDC.exe program becomes a display client only. 

This is the port used for the client to communicate with 

the Windows Service. It should not be changed unless 

the port conflicts with another applications’ use.  

Service Address 

When Local Service is unchecked this specifies the 

TCP/IP address of the machine that the Windows 

Service is running on. It will allow the service to run on 

another PC and still allow the display of collected data 

on the local machine. 

 

When the application is run as a service, the P911PDC.exe program becomes a display 

client only. The real work of capturing printer data and storing it in a database is done 

by the P911PDCService.exe program. As the service collects and stores data, it also sends 

it to any display client that is connected to it. The display client does not need to be 

running for the printer data to be captured. 

 

When the application is not run as a service, the P911PDCService.exe program is not 

used and the P911PDC.exe program becomes both the capture and display application. 

In this case, it must be running before any printer data is captured. In order to run, a 

user must log on to the PC it is installed on. The application then must be either started 

manually, or the option to start with windows must be checked. 

 

Pressing the OK or Apply button makes the changes immediately. The panes and 

windows displayed will change according to which printers are being used, as described 

in the next section. 
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2.3 Screen Format 
 

The screen display of the Provincial 9-1-1 Printer Data Capture application changes 

depending upon which serial ports are assigned. In the case of a single LOG printer port 

being read, the display will look like: 

 

 
 

The panel at the top displays the individual fields as extracted from the raw 9-1-1 LOG 

printer output. These are the fields that are stored in the databases. Also in the LOG 

printer pane are buttons that allow you scroll through the history of 9-1-1 calls that have 

occurred. The two small windows under the history scroll back buttons indicate the 

current history entry number that is displayed, and the total history entries that have 

been collected so far, up to the configured maximum. 
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The window directly underneath the LOG printer fields pane is used to display the raw 

LOG printer data as read directly from the serial port. The bottommost window is the 

logging window and is used to display informational and error messages. 

 

If the Real-time printer serial port is also configured, the Real-time field pane and Real-

time raw serial window will also be displayed. 

 

The status bar at the bottom will be blank if the application is not run as a Windows 

Service. If running as a service, the first status panel displays the status of the service as 

Running, Stopped, or Not Installed. The second panel displays the client connection 

status, normally Connected if the service is running. 

 

2.4 Statistics 
 

 

 

 



Provincial 9-1-1 Printer Data Capture Operation 
Search Screen 

 

 2-10 

2.5 Search Screen 
 

Pressing the Search button on either the LOG or Realtime printer panels brings up the 

Search screen. 
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2.6 Database Fields 
 

The Provincial 9-1-1 Printer Data Capture application splits the raw LOG printer serial 

port printer record into its component fields and stores it in the user-defined database. If 

a real-time printer port is also configured and attached, the real-time printer data is also 

split into its component fields and merged with the existing LOG printer data. The 
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following table lists the names and data types of all the fields collected. These must be 

defined in a table named callstats  within the database to be collected properly. 

 

Table 4 - callstats table 

Field Name Data Type Size Field Description 

CaptureTime Date/Time 8 
The date and time the data was captured from the LOG printer (PC 
UTC) 

ANI Text 10 The telephone number of the 9 -1-1 caller 

PSAPName Text 16 The PSAP name of the answering agency 

Position Text 5 The position answering the call (may not be accurate)  

Login Text 5 The login time of the position (usually null  for non-ACD) 

OfferTime Date/Time 8 The time the 9-1-1 call was offered (DMS-100 time) 

AnswerTime Date/Time 8 
The time the 9-1-1 call was answered (DMS-100 time). Null for 
abandoned attempts. 

TransferTime Date/Time 8 
The time the 9-1-1 call was transferred to another agency. (DMS-
100 time) Null for non -transferred calls. 

DisconnectTime Date/Time 8 The time the 9-1-1 call was disconnected (DMS-100 time) 

TransferDN Text 10 
The directory number used to transfer the 9 -1-1 call. Null for non-
transferred calls. 

TransferPSAPName Text 16 
The PSAP name of the agency the 9-1-1 call was transferred to. Null 
for non-transferred calls. 

TransferAnswerTime Date/Time 8 
The time the call was answered at the transferred-to agency (DMS-
100 time). Null for non-transferred calls. 

ESRD Text 10 
The Emergency Service Routing Digits for a cellular call. Null for non-
cellular calls or for carriers that do not subscribe to enhanced 9-1-1 
services. 

Name Text 63 The name of the customer placing the 9-1-1 call. 

Address Text 68 The address of the customer placing the 9-1-1 call. 

Municipality Text 30 The municipality of the customer placing the 9 -1-1 call. 

PostalCode Text 7 
The postal code of the customer placing the 9-1-1 call. May be null 
or ñNPCò 

ServiceClass Text 4 

The service class of the customer placing the 9-1-1 call. May be one 
of 

¶ RES 
¶ BUS 
¶ CELL 
¶ UNKN (for ANI failure) 
¶ COIN (may not be implemented on 9-1-1 side) 

ESZ Text 5 
The 5 digit Emergency Services zone of the customer placing the 9-
1-1 call. 

RTCaptureTime Date/Time 8 
The date and time the data was captured from the real -time printer 
(PC UTC) 

RTCallTime Date/time 8 
The date and time the call was answered according to the real-time 
printer 

RTPosition Text 20 
The Answering position as sent in the CAD packet, or ñ(abandoned 
call)ò if the call was not answered. 

FireAgency Text 30 The name of the Fire dispatch agency for the callerôs ESZ. 

FirePhone Text 10 The telephone number of the Fire dispatch agency. 
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PoliceAgency Text 30 The name of the Police dispatch agency for the callerôs ESZ. 

PolicePhone Text 10 The telephone number of the Police dispatch agency. 

EMSAgency Text 30 The name of the EMS dispatch agency for the callerôs ESZ. 

EMSPhone Text 10 The telephone number of the EMS dispatch agency. 

ServiceAddressComments Text 120 The Service Address Comments associated with the caller. 

LSPName Text 15 The name of the Local Service Provider for the telephone line. 

LSPPhone Text 10 The Local Service Providerôs contact number. 

 

The database table may be modified to add additional keys for performance 

improvements when sorting, searching, and reporting, as long as the field names, file 

sizes, and data types are not modified. 

2.7 Operation 
 

When started, if the LOG printer and/or Real-time printers are configured, the utility 

will immediately begin reading from the serial ports and storing and displaying data. To 

exit the program, select File->Exit from the menu. To stop and start reading from the 

ports without exiting, select File->Start or File->Stop. 

 

If the utility is reading from both a LOG printer port and a real-time printer port, the 

utility will attempt to merge the data from both data streams into the same database 

record. In some cases, the merge will fail, and both types of records will be stored in the 

database. The merge failure is due to the fact that the timestamps for the LOG printer 

data and the real-time printer are from different systems, and the clocks will probably 

not match. For example, if the real-time printer data is stored first, when the LOG 

printer data is captured, the real-time printer data is looked up by answer time. Since 

the answer time for the real-time data will in all likelihood not match the answer time 

for the LOG printer data exactly, a “rough” match is done that may not always succeed if 

the clocks are too different. 

 

Informational and error messages are always logged in the bottom logging window pane. 

In addition, they are also logged to a file called “LogFile yyyy-mm-dd.txt” in the same 

folder that the utility is installed. This log file is automatically rolled over daily at 

midnight. If there is a database problem, and no data can be stored in any database, the 

call data will be logged as a single string record having the fields delimited by a vertical 

bar character. For data read from the LOG printer, the record is preceded by the 

keyword “LOGDATARECORD:”. Real-time printer data is preceded by the keyword 

“RTDATARECORD:”. If the storage database becomes damaged or unavailable, the data 

from the log provides a data stream that may be imported into the database once the 

problem is resolved. 
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3  Searching and Reporting 
 

The Printer Data Capture application is also supplied with a Microsoft Access database 

utility called P911 Reporting.mdb . The utility includes a menu system that allows you to 

call up a search module, reports, and maintenance and customization forms. A sample 

report that breaks down 9-1-1 call data by hour of day is also included. If you are familiar 

with Microsoft Access, you may create your own reports and modules and integrate them 

into the menu system using the Access Switchboard Manager. 

 

In order to be distributed without affecting the customers’ data, the Searching and 

Reporting database uses links into the external 9-1-1 call statistics data table. There are 

also several external data tables that are needed to customize 9-1-1 reports. The links 

are created or redefined by the “Select Database” menu item found on the Maintenance 

menu. 

 

An empty Microsoft Access database, Installation.mdb is provided that contains empty 

site-specific tables. 

 

The tables and their fields are documented in the following table. 

 

Table 5 - Site specific tables in Installation.mdb 

Table Name Field Name Data Type Size Description 

tblInstallation  
 
This table contains data that 
appears on the sample 
reports and menu. 

ID Text 5 A unique installation identifier key . 

Name Text 50 The name of the installation. This name 
appears at the top of the sample reports and 
on the main menu.  

Logo OLE Object -- A bitmap logo that appears on the main 
menu and at the top of sample reports . 
Please not that the MySQL database does not 
support the storage of bitmap data.  

tblAgency  
 
This table provides 
descriptions and Agency 
types for the PSAP Names 
found in the call records. The 
PSAP name corresponds to a 
call answer centre. 

PSAPName Text 16 The name of the PSAP as reported by the 
LOG printer. 

Description Text 32 The description of the call answer centre. 

Type Text 1 A character describing the type of call 
answer centre: 

¶ P - Police 
¶ F - Fire 
¶ E - EMS 
¶ O- Other 
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Table Name Field Name Data Type Size Description 

t blExchange  
 
This table provides 
descriptions for the local 
exchanges, used in the 
Exchange report. 

NPANXX Text 6 The NPANXX, first 6 digits of a telephone 
number. 

t blESZ 
 
This table provides 
descriptions for the local 
Emergency Services Zones. 

ESZ Text 5 The 5 digit Emergency Services Zone 
number. 

Description Text 50 The description of the ESZ. 
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3.1 Main Menu 
 

Initial running of the utility will result in presentation of the “Select Data Source” form 

in order to choose the location where the 9-1-1 call statistics are being collected, and also 

the database location of the site-specific customization tables. Subsequent starts will be 

presented with a menu window. 

 

 
 

 

3.2 Search 
 

There are two types of searches that can be performed on the call data. The first search 

type searches only the realtime printer records, provided you are collecting data from a 

realtime printer. Using this search you can display and print call data for calls that are 

still in progress. The second type of search searches only the LOG printer records. Using 

this search, you may only display and print call record data for calls that have already 

completed. Either search allows you to specify any number of search criteria for finding 

relevant call records. In addition, the Realtime Print search window has a button that 

will display the 10 most recent calls. 
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The Search button performs the search based on the data entered on the form. The 

results are displayed in the lower portion of the form. The Print Preview button 

displays a sample of the search results and the Print button will print the search results 

without a preview. The Clear button clears the form of the entered search data allowing 

you to input new values. The Cancel button closes the form and returns you to the 

previous menu. 

 

Some pointers to take into account when entering search parameters: 

 

¶ If a search field is left blank, it is not used as a search criterion. 
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¶ For the date/time fields, if you specify both a lower and upper bound, the upper 

bound will change to 1 second less than the entered date if you specify a date 

with no time. For instance, if you enter 1-JAN-2001 in the lower bound field, and 

2-JAN-2001 in the upper bound field, the upper bound field will change to 1-JAN-

2001 23:59:59. This is done so that records falling exactly on midnight are not 

included. 

¶ For date/time fields, if you only specify a lower bound, all records having a date 

greater than or equal to the date are selected. 

¶ For date/time fields, if you only specify an upper bound, only records less than or 

equal to the date are selected. 

¶ For text fields that do not have dropdown boxes, and string entered is searched 

using a partial match. That is, records are search for fields containing the search 

string. If you want to restrict the search further, use the wildcard characters “*” 

and “?”. The “*” wildcard matches any number of characters or zero characters. 

The “?” wildcard matches exactly one character. For instance entering “BOB*” in 

the Name field will find all records with names starting with “BOB”. Therefore 

just entering the string “BOB” is equivalent to entering “*BOB*”. 

¶ For text fields with dropdown boxes, you may select a value from the dropdown 

list, which represent all unique values found in the stored data, or enter your 

own value. 

 

3.3 Reports 
 

The Reports menu option displays the Reports form, allowing you to call up various 

9-1-1 statistical reports. As initially shipped, only the “Call Distribution by Hour” report 

is provided. 
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Choosing the “Call Distribution by Hour” report brings up a report selection criteria 

form: 

 

 
 

The Call Time Distribution Report  report reports the number of 9-1-1 calls per hour for a 

given range of days for a selected PSAP. 

 

The report may only select a months worth of data. Any dates entered in the Start Month 

or End Month fields are automatically reformatted to “Month, Year”. To save time, you 

need only enter a date such as “Jan 2001” in either of these fields. If a date is entered 

only in the Start Month, only that month will be reported. The PSAP Name dropdown 

box will list the unique values found in the PSAP Name field of collected 9-1-1 call data. 
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3.4 Maintenance 
 

The Maintenance menu option displays the Maintenance sub-menu, allowing you to 

customize the site-specific tables used by the reporting modules. It also allows you to 

choose the location of the call statistics table and the site-specific customization tables. 

 

 
 

The Installation Table maintenance menu allows you to choose a site specific ID, and the 

name and bitmap logo that will appear on the menu and at the top of reports. Right click 

the logo box to enter a new logo, or double click it to edit a stored logo. 
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The Choose Database menu item brings up a form that allows you to specify where the 

database where the 9-1-1 call statistics data is being stored and where the site specific 

customizable tables tblInstallation , tblAgency , tblExchange , and tblESZ  are stored. You 

may select either a Microsoft Access Database or an ODBC database. 
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